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About this document

Who should

This document describes how to use the Device Inventory tools to produce
reports on the hardware and software configuration of selected devicesin
your network.

The following topics are discussed in this section:

e “Who should read this document and why” (page 11)

e “What you need to know” (page 11)

e “How this document is organized” (page 12)

e “What's new in this document” (page 12)

e “Related documents’ (page 14)

read this document and why

This document isintended for personnel who use and customize the Device
I nventory toolsto produce reports on the hardware and software configuration
of Passport 7000, Passport 15000, and Passport 20000 series modules, and
DPN-100 modulesin their networks.

What you need to know

The Device Inventory tools lets you produce reports from a graphical user
interface (GUI) or acommand line. Before using the Device Inventory tools,
you should have a basic knowledge of Sun workstations and the UNIX
operating system, and be familiar with Preside Multiservice Data Manager
(MDM) user interface. To customize existing reports and to create new
reports, you need to know how to program in DtK sh script and how to use EPI
libraries.

Preside MDM Device Inventory Tools User Guide 14.3RSUP



12  About this document

How this document is organized

This document consists of an introductory chapter that provides an overview
of the Passport and DPN Inventory tools. This chapter isfollowed by chapters
describing each tool in greater detail and that providing examples of the
reports that you can produce.

241-6001-808 Preside MDM Device Inventory Tools User Guide containsthe
following sections:

“Introducing the Inventory Reportstools’ (page 15) gives a brief
overview of the Inventory Reportstool for DPN and Passport devicesand
their functionality.

“Passport Inventory Reports tool” (page 19) describes how you can
produce reports on the Passport modules in your network.

“DPN Inventory Reportstool” (page 35) describes how can produce
reports on the DPN modulesin your network.

“Passport Inventory Reports’ (page 49) provides examples of thereports
that come with the Passport | nventory tool.

“DPN Inventory Reports’ (page 67) provides examples of the reports
that come with the DPN Inventory tool.

What's new in this document
There are no changes in this document for this release.

Text conventions
This document uses the following text conventions:

nonproportional spaced plain type

Nonproportional spaced plain type represents system generated text or
text that appears on your screen.

nonproportional spaced bold type

Nonproportional spaced bold type represents wordsthat you should type
or that you should select on the screen.

241-6001-808 14.3RSUP



About this document 13

italics
Statements that appear in italicsin a procedure explain the results of a
particular step and appear immediately following the step.

Words that appear in italicsin text are for naming.

[opti onal _par anet er ]

Words in square brackets represent optional parameters. The command
can be entered with or without the words in the square brackets.

<general _ternp

Wordsin angle bracketsrepresent variableswhich areto be replaced with
specific values.

UPPERCA SE,|lowercase

In Preside Multiservice DataManager (MDM), uppercase and lowercase
lettersthat appear in UNIX commands and parameters must be matched
exactly. The system matches upper and lowercase characters differently.

UPPERCA SE,|owercase

Passport commands are not case-sensitive and do not have to match
commands and parameters exactly as shown in this document, with the
exception of string optionsvalues (for example, file and directory names)
and string attribute values.

This symbol separates items from which you may select one; for
example, ON|OFF indicates that you may specify ON or OFF. If you do
not make a choice, adefault ON is assumed.

Three dots in acommand indicate that the parameter may be repeated
more than once in succession.

Preside MDM Device Inventory Tools User Guide 14.3RSUP



14  About this document

The term absolute pathname refers to the full specification of a path starting
from the root directory. Absolute pathnames always begin with the slash (/)
symbol. A relative pathname takes the current directory as its starting point,

and starts with any a phanumeric character (other than /).

Related documents
See the following documents for related information:

e 241-6001-211 Preside MDM Embedded Programming I nterface
Reference Guide

241-6001-808 14.3RSUP
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Chapter 1
Introducing the Inventory Reports tools

This chapter provides an overview of the | nventory Reportstool for DPN and
Passport devices. In this chapter, you can find the following information:

*  “About the Inventory Reportstools’ (page 15)

* “Inventory Reports configuration files’ (page 16)
e “Customizing and creating reports’ (page 16)

e “Starting the Inventory Reportstools’ (page 16)

About the Inventory Reports tools

The Inventory Reports tools are reporting tools that let you report on the

hardware and software configuration of selected devicesin your network.
Currently, you can produce reports on Passport 7000 and Passport 15000
series modules, and DPN-100 modules.

The Passport and DPN Inventory Reportstools come with aset of pre-defined
reportsthat you can use. You can also customize these reports and design new
reports.

Seedlso:

*  “Passport Inventory Reports tool” (page 19)

* “DPN Inventory Reportstool” (page 35)

* “Inventory Reports configuration files’ (page 16)
e “Customizing and creating reports’ (page 16)

e “Starting the Inventory Reportstools’ (page 16)

Preside MDM Device Inventory Tools User Guide 14.3RSUP



16 Chapter 1 Introducing the Inventory Reports tools

Inventory Reports configuration files
Thereisaconfiguration file for each device for which you can produce

reports. You can copy and edit these configuration filesto add entries for the
new reports that you design.

See aso...

»  “Passport inventory reports configuration file” (page 21)

* “DPN inventory reports configuration file” (page 37)

Customizing and creating reports

The Passport and DPN inventory reports are generated by DeskTop Korn
Shell (DtKsh) scripts. These scripts use the Embedded Programming
Interface (EPI) libraries to obtain information directly from the devices. For
more information on DtKsh and EPI, see 241-6001-211 Preside MDM
Embedded Programming Interface Reference Guide.

You can customize existing inventory reports and create new reports. By
using a script-based approach such as DtK sh, you can change and create
reports without the need for recompiling.

Seedso...

e “Customizing and creating Passport Inventory Reports’ (page 21)

e “Customizing and creating DPN inventory reports’ (page 37)

Starting the Inventory Reports tools
For Passport and DPN devices, you can start the Inventory Reportstoolsfrom

the Preside MDM window or by using line commands. In addition, there are
line commands that let you produce Inventory reports independently of the
GULI.

Seedso...

e “Starting the Passport Inventory Reportstool” (page 20)

»  “Producing reports using acommand line” (page 31)

e “Starting the DPN Inventory Reportstool” (page 36)

241-6001-808 14.3RSUP
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e “Producing reports using acommand line” (page 46)

Preside MDM Device Inventory Tools User Guide 14.3RSUP
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Chapter 2
Passport Inventory Reports tool

This chapter describes the Inventory Reports tool for Passport devices and
contains procedures for using it. The Passport Inventory Reports tool
supports Passport 7000, Passport 15000, and Passport 20000 series modules.

In this chapter, you can find the following information:

“About the Passport Inventory Reports tool” (page 19)

“ Starting the Passport I nventory Reports tool” (page 20)

e “Customizing and creating Passport Inventory Reports’ (page 21)
e “Passport inventory reports configuration file” (page 21)

e “Passport Inventory Reports tool window” (page 23)

e “Passport Inventory Reports tool dialogs’ (page 26)

e “Passport Inventory Reports tool procedures’ (page 30)

e “Using the keyboard” (page 32)

About the Passport Inventory Reports tool
The Passport I nventory Reportstool lets you produce reports for the

modulesin a Passport group or for a specific module. In addition to using
existing reports, you can design custom reports. The reports can be produced
from agraphical user interface or from a command line.

Seedso...

* “Customizing and creating Passport Inventory Reports’ (page 21)

»  “Passport inventory reports configuration file” (page 21)

Preside MDM Device Inventory Tools User Guide 14.3RSUP



20 Chapter 2 Passport Inventory Reports tool

e “Passport Inventory Reports tool window” (page 23)

»  “Passport Inventory Reports tool dialogs’ (page 26)

*  “Passport Inventory Reports tool procedures’ (page 30)
e “Using the keyboard” (page 32)

Starting the Passport Inventory Reports tool

Inthe Preside M DM window, select Configuration -> Passport Devices->
Inventory Reports. This opens the Passport Inventory Reports Tool
window.

As an dternative, you can use aline command to launch the Passport
Inventory Tool window. Enter the following command:

[ opt/ Magel | anNVB/ bi n/ pprep [-group <group_nane> |
[-comp <nodul e_nane>] [-rep <report_nanme>] [-h]

where:

group_nane isthe name of the Passport group on which you want to
report. Thisfield is not case-sensitive.

- h displays online help for this command.

modul e_nane isthe name of the Passport module on which you want to
report. Thisfield is not case-sensitive and can bein any valid format, for
example, -comp nodelA, -comp EM/nodelA, or -comp EM nodelA.

report_nane istheidentifier of areport. When you usethe -rep parameter,
the specified report is generated as soon as the Passport Inventory Tool
window opens. The names of available reports are specified in the
configuration file pprep.reports using the option

createReportBTN <report_name>. See“ Configurationfileformat” (page 22)
for more information.

Example
The following command opens the Passport Inventory Tool window and
produces the Frame Relay Services Report for Passport module PP1:

241-6001-808 14.3RSUP
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[ opt/ Magel | anNMS/ bi n/ pprep -conp EM PP1
-rep PP_FR REPORT

Customizing and creating Passport Inventory Reports

The Passport inventory reports are generated using DeskTop Korn Shell
(DtKsh) scripts. These scripts use the Embedded Programming Interface
(EPI) libraries to obtain information directly from the Passport nodes.

To customi ze existing reports and create new reports, you need to know how
to program in DtK sh script and how to use the EPI libraries. For more
information, see 241-6001-211 Preside MDM Embedded Programming
Interface Reference Guide.

The Passport Inventory Reports tool searches for the report scriptsin the
following directories and in the following order:

1 $HOME/MagellanNMS
This directory contains the report scripts that are available to asingle
Preside Multiservice Data Manager (MDM) user.

2 /opt/MagellanNM S cfg/macros/user
This directory contains the report scripts that are availableto all MDM
users.

3 /opt/MagellanNMS/lib/macros/nms
This directory contains the report scripts that come with the MDM
software. These report scripts should never be modified. When you need
to override these report scripts or when you create new report scripts,
place the updatesin either the first or second location.

When you create a new report, you need to add a new entry to the Passport
inventory reports configuration file pprep.reports. For more information, see
“Passport inventory reports configuration file” (page 21).

Passport inventory reports configuration file

All of the Passport inventory reports are specified in the configuration file
pprep.reports. You can copy and customize thisfileto reflect any new reports
that are added to the Passport Inventory Reportstool.

See dso...
e “Configuration file location” (page 22)

Preside MDM Device Inventory Tools User Guide 14.3RSUP



22 Chapter 2 Passport Inventory Reports tool

e “Configuration file format” (page 22)

Configuration file location
The Passport I nventory Reportstool searches for the configuration filein
the following directories and in the following order:

1 $HOME/MagellanNMS
To customizethereportsavailableto asingle user, copy the configuration
file to this directory and make your changes.

2 /opt/MagellanNM S/ cfg
To customize the reports available on aworkstation, copy the
configuration file to this directory and make your changes.

3 /opt/MagellanNMSlib/cfg
Thisdirectory isthe default location of the configuration file. Do not edit
the configuration file in this directory; instead use it as the source when
you want to copy pprep.reports to the other directories.

Configuration file format
The pprep.reports file contains DtK sh commands in the following format:

createReportBtn <report_nanme> \
“<report_button_| abel > \

“<bt n_mmenoni ¢c>" “<btn_accel erator>" \
“<btn_acc_| abel >" \

“scriptReport <report_script_name>"

where:

bt n_acc_| abel isthetext string, specifying the keyboard accel erator for
thisreport, that is displayed in the Reports menu.

bt n_accel er at or isthe keyboard accelerator for this report.
bt n_menoni c isthe keyboard mnemonic key for this report.

report_button_| abel isthetext string, specifying thetitle for this
report, that is displayed in the Reports menu.

report_nanme isauniquereport identifier. No spaces are allowed.

241-6001-808 14.3RSUP
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report_script_name isthename of the reporting script. The Passport
Inventory Reportstool searchesfor the script in the following directories
and in the following order:

$HOME/MagellanNM S

/opt/MagellanNM S/cfg/macros/user

/opt/MagellanNM S/lib/macros/nms.

You can override the default directories by including the full pathname as part
of report_script_name.

Example 1

createReportBtn PP_FR REPORT \
“Frane Relay Services Report” \
“FTtCrl <Key>f" “Crrl+f" 0\
“script Report ppfrrep”

Example 2
You can produce the same report as above, but from a directory of your
choice by including the full pathname:

createReportBtn PP_FR REPORT \

“Frane Relay Services Report” \
“FTfCr] <Key>f" “Cirl 47\

“script Report /home/ nnsuser/bin/ppfrrep”

Passport Inventory Reports tool window

The Passport I nventory Reports tool window contains the following
sections:

*  “Menubar” (page 24)

»  “Passport Group field” (page 25)
e “Modulefield” (page 26)

e “Report area’ (page 26)

Seethe figure “ Passport Inventory Tool window” (page 24) for an example of
the Passport | nventory Reports Tool window.

Preside MDM Device Inventory Tools User Guide 14.3RSUP
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Figure 1

Passport Inventory Tool window

‘ 4| Passport Inventory Tool | @ |J
File Edit Reports Options Help

Fassport Group: |t ands/or Module: |y

Menu bar
The menu bar islocated at the top of the Passport Inventory Reports Tool
window. See the following sections for information on the menu bar entries:

e “Filemenu” (page 24)
e “Edit menu” (page 25)
e “Reports menu” (page 25)
e “Options menu” (page 25)

File menu
The File menu contains the following options:

e Saveasopensthe Save Report to Filedialog. Thisdialog lets you save
the report output to afile that you specify. See also “ Save Report to File
dialog” (page 28).

* Print opensthe Print Report dialog, which allows you to print the
report output. See also “Print Report dialog” (page 29).

» Exit exitsthe Passport | nventory Reportstool.

241-6001-808 14.3RSUP
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Edit menu
The Edit menu containsoptionsfor editing text inthereport area. The options
are:

«  Cut removes any selected text and placesit in acut/copy buffer.
» Copy copies any selected text and placesit in a cut/copy buffer.

» Pasteplacesthelast cut or copied text at the insertion point in the report
area.

» Delete deletes any selected text.

Reports menu
The Reportsmenu lists all available Passport inventory reports. You can add

custom reports to this menu. Until you specify a Passport Group name and/
or M odule name on the Passport I nventory Reportswindow, all reportsare
grayed out and unsel ectable except for List Available M odulesand Groups.

The reportslisted in the Reports menu are specified in the configuration file
pprep.reports. For more information on thisfile, see “Passport inventory
reports configuration file” (page 21).

Options menu
The Options menu contains the following options:

« Append to Existing Text lets you add any new report output to the
existing report output. If you do not select this option, any new report
output replaces the existing report output. By default, thisoptionis
enabled.

» GenerateCSV Output letsyou save any new report output asCSV data.
You can use CSV dataasinput to a spreadsheet. If you do not select this
option, any new report output is displayed as usual. By default, this
option is disabled.

Passport Group field
Thisfieldisoptional. Enter the name of the Passport group on which you want
to report. If you want information on a particular module, leave thisfield
empty and enter the module name in the M odule field.

Preside MDM Device Inventory Tools User Guide 14.3RSUP



26 Chapter 2 Passport Inventory Reports tool

If you enter the Passport group and not a module, the report is produced for
all modules in the specified group. If you do not specify a Passport group or
amodule name, the only report you can createisL ist AvailableM odulesand
Groups.

Module field

Thisfield isoptional. You can enter the name of the module on which you
want to report.

When you usethe M odulefield and not the Passpor t Group field, the correct
group is obtained from the HGDS server. If you do not specify a Passport
group or amodule name, the only report you can createisList Available
Modules and Groups.

Report area

This scrollable area displays the reports you create and any messages
generated by the Passport Inventory Reportstool.

Passport Inventory Reports tool dialogs

See the following sections for information on Passport Inventory Reports
tool dialogs:

e “Passport Authentication dialog” (page 26)
e “Card Inventory Options dialog” (page 27)
» “Save Report to Filedialog” (page 28)

*  “Print Report dialog” (page 29)

Passport Authentication dialog
The Passport Authentication dialog isdisplayed when you try to generate a
report and you do not have a connection to the required Passport group. This
dialog prompts you for a Passport group, user 1D, and password, which are
required before authentication can take place. The buttons are:

e OK completes the connection and closes the dialog.

»  Cance stopsthe connection attempt and closes the dial og.

241-6001-808 14.3RSUP
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For anillustration of the Passport Authentication dialog, see the figure
“Passport Authentication dialog” (page 27).

Figure 2
Passport Authentication dialog

— Passport Authentication

Authentication for node "HODER1G". ..

Fassport Group: |UNI‘JERE§E

User ID: |

Fassword : |

_ 0K Cancel Help

Card Inventory Options dialog
The Card Inventory Options dialog opens when you select the Passport
Card Inventory command from the Reports menu. Thisdialog letsyou sort
the Passport card inventory by card type or report on a card type that you
specify. The Card TypeFilter field is not case-sensitive and you cannot use
wildcards.

The buttons are:

e OK usestheinformation you enter to produce the Passport Card
Inventory report and closes the dialog.

e Cancd closesthe dialog without producing the Passport Card
I nventory report.

Preside MDM Device Inventory Tools User Guide 14.3RSUP
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Ror an illustration of the Card Inventory Options dialog, see the figure
“Card Inventory Options dialog” (page 28).

Figure 3
Card Inventory Options dialog

— Card Inventory Options

Card Inwventory Options. ..

| Sort by Card Type _|Filter on Card Type

Card Type Filter: |

Ok Cancel Help

Save Report to File dialog

The Save Report to File dialog lets you specify the name of afilefor saving
the current report output

The buttons are;

»  OK savesyour report in the file you specify and closes the dial og.
» Filter letsyou choose what files are listed.

e Cancd closesthe dialog without saving your report.

For anillustration of the Save Report to File dialog, see the figure “ Save
Report to File dialog” (page 29).
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Figure 4
Save Report to File dialog

~| Save Report to File

Directories Files

.. = |.alias =
MPA_data .alias.old |
NS .cshre

Jll .cshrec.old
MagellanHMs dtprofile

NODER16G .dtprofile.old
sanity_test .login

shirley % |-login.old ¥
[ [ | (] - =

Selection

|/local/users/nmguestﬁ

_ 0K | |Filter| Cancel Help

Print Report dialog

The Print Report dialog lets you enter a printer name when you print a
report.

The buttons are;
*  OK printsthereport and closes the dialog.
» Cancd closesthe dialog without printing the report.

For an illustration of the Print Report dialog, see the figure “Print Report
dialog” (page 30).
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Figure 5
Print Report dialog

~| Print Report

Printer:

| (]9 ‘ Cancel Help

Passport Inventory Reports tool procedures

See the following sections for information on Passport Inventory Reports
procedures:

e “Producing reports using the Passport Inventory Reports tool window”
(page 30)

»  “Producing reports using acommand line” (page 31)

Producing reports using the Passport Inventory Reports tool
window
You can select a Passport group, module, and report from the Passport
Inventory Reportstool window. You need to establish a connection to a
Passport group or module before you can produce a report.

1 Onthe Passport Inventory Tool window, in the Passport Group field,
enter the Passport group. Optionally, you can enter the module name in
the and/or Module field.

If you specify only the Passport group, the report is produced for all
modules in the specified group.

If you specify only the module, the correct group is obtained from the
HGDS server and the report is produced only for the specified module.

Note: If you enter nothing in the Passport Group and the and/or
Module fields, the only report you can produce is List Available Modules
and Groups.
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2 From the Options menu, deselect Append to existing text if you want
the new report output to replace existing report output. By default,
Append to existing text is selected.

3 Fromthe Options menu, select Generate CSV output if you want to save
the new report output as CSV data. By default, Generate CSV output is
deselected.

4  From the Reports menu, select a report.

If no connection exists to the required Passport group, the Passport
Authentication dialog opens. See “Passport Authentication dialog”
(page 27).

5 Inthe Passport Authentication dialog, enter the Passport Group, User
ID, and Password and click OK.

When a valid connection exists, the report is created and appears in the
report area.

If there is a connection to the Passport group, the report is created and is
displayed in the report area.

Producing reports using a command line
You can use acommand line to produce reports independently of the
graphical user interface. The report output goes to stdout. The command
syntax is:

/ <pat hnane>/ <r eport _scri pt _nane>
[-group <group_name> ] [-u <userid> -p <password>]
[-csv] [-st]
[-ft <card_type>] [-h] [modul e(s)]

where:

pat hnane isthe directory where the report script resides.

report_script_name isthe script name of the report that you need to
produce. The script names of available reports are specified in the
configuration file pprep.reports using the option

scriptReport <report_script_name>. See “Configuration file format”
(page 22) for more information.

- group <group_nane> isthe name of the Passport group on which you
want to report. Thisfield is not case-sensitive.
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-u <userid> isthe userid for logging on to a Passport group.
-p <passwor d> isthe password for the userid specified by the -u option.

-csv formatsthe report output in CSV format.

-st isused only for the Passport Card Inventory. This option sorts the card
inventory by card type.

-ft <card_type> The-ft option filtersthe card inventory by the specified
card type. <card type> isused only for the Passport Card Inventory.

- h displays online help for this command.

modul e(s) isthe name(s) of the Passport modul e(s) on which you want to
report. Thisfield is not case-sensitive.

Note: All command options must appear before the module names.

Example

The following command is used to produce the Passport ATM Services
Report for group ALPHA. In this case the directory containing the
report scripts that come with the MDM software is used.

[ opt/ Magel | anNVB/ | i b/ macr os/ nns/ ppat nrep - group ALPHA

Using the keyboard

You can produce any Passport inventory report by using its command
accelerator, which is displayed in the Reports menu.

In addition, the Passport | nventory Reportstool providesthe following
keyboard shortcuts:

* Citrl+sfor Saveas

e Ctrl +pfor Print

+  Ctrl+efor Exit
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Some characters in menus and in menu items have an underscore (). These
characters are mnemonics that you can use instead of using the mouse. Use
the Meta key in combination with the mnemonics.

Examples
Metat+f on the Passport Inventory Reports tool window opensthe File
menu.

Metatc on the Edit menu is the same as Copy.

Preside MDM Device Inventory Tools User Guide 14.3RSUP



34 Chapter 2 Passport Inventory Reports tool

241-6001-808 14.3RSUP



35

Chapter 3
DPN Inventory Reports tool

This chapter describes the DPN Inventory tool and contains procedures for
using it. In this chapter, you can find the following information:

*  “About the DPN Inventory Reportstool” (page 35)

» “Starting the DPN Inventory Reportstool” (page 36)

e “Customizing and creating DPN inventory reports’ (page 37)
* “DPN inventory reports configuration file" (page 37)

“DPN Inventory Reportstool window” (page 39)

“DPN Inventory Reportstool dialogs’ (page 42)

“DPN Inventory Reportstool procedures’ (page 45)
e “Using the keyboard” (page 47)

About the DPN Inventory Reports tool

The DPN Inventory Reportstool lets you produce reports for the modules
under an operations agent (OA) or for aspecific module. In addition to using
existing reports, you can design custom reports. The reports can be produced
from a GUI or from acommand line.

See aso...

e “Customizing and creating DPN inventory reports’ (page 37)

* “DPN inventory reports configuration file” (page 37)

*  “DPN Inventory Reportstool window” (page 39)
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e “DPN Inventory Reportstool dialogs’ (page 42)
*  “DPN Inventory Reportstool procedures’ (page 45)
» “Using the keyboard” (page 47)

Starting the DPN Inventory Reports tool

To open the DPN I nventory Reportstool window, ,from the Preside MDM
window, select Configuration -> DPN Devices -> Inventory Reports.

Asan alternative, you can use aline command to launch the Device Inventory
main window. Enter the following command:

[ opt/ Magel | anNVB/ bi n/ dpnrep [-o0a <oa_nane> ]
[-comp <nodul e_nane>] [-rep <report_nanme>] [-h]

where:

- h displays online help for this command.

modul e_nane isthe name of the DPN module on which you want to report.
Thisfield is not case-sensitive and can be in any valid format, for example,
-comp nodelA, -comp PM/nodelA, or -comp PM nodelA.

oa_name isthe name of the OA on which you want to report. Thisfield is
not case-sensitive.

report_nanme istheidentifier of areport. When you usethe -rep parameter,
the specified report is generated as soon as the DPN Inventory main window
opens. The names of available reports are specified in the configuration file
dpnrep.reports using the option

createReportBTN <report_name>. See“ Configurationfileformat” (page 38)
for more information.

Example
The following command opens the DPN Inventory main window and
produces the DPN PE Report for DPN module RM 1:

[ opt/ Magel | anNM5/ bi n/ dpnrep - oa BNROA -conp PM RML
-rep DPN_PE_REPORT
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Customizing and creating DPN inventory reports

The DPN inventory reportsare generated using DeskTop Korn Shell (DtKsh)
scripts. These scripts use the Embedded Programming I nterface (EPI)
libraries to obtain information directly from the DPN nodes.

To customize existing reports and create new reports, you need to know how
to program in DtK sh script and how to use the EPI libraries. For more
information, see 241-6001-211 Preside MDM Embedded Programming
Interface Reference Guide.

The DPN Inventory Reportstools searches for the report scripts in the
following directories and in the following order:

1 $HOME/MagellanNMS
This directory contains the report scripts that are available to asingle
Preside Multiservice Data Manager (MDM) user.

2 /opt/MagellanNM S/ cfg/macros/user
This directory contains the report scripts that are availableto all MDM
users.

3 /opt/MagellanNMS/lib/macros/nms
This directory contains the report scripts that come with the MDM
software. These report scripts should never be modified. When you need
to override these report scripts or when you create new report scripts,
place the updates in either the first or second location.

When you create a new report, you need to add a new entry to the DPN
Inventory configuration file dpnrep.reports. For more information, see“DPN
inventory reports configuration file” (page 37).

DPN inventory reports configuration file
All of the DPN inventory reports are specified in the configuration file

dpnrep.reports. You can copy and customizethisfileto reflect any new reports
that are added to the DPN I nventory Reportstool.

See dso...

*  “Configuration file location” (page 38)

e “Configuration file format” (page 38)
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Configuration file location
The DPN Inventory Reportstool searches for the configuration filein the
following directories and in the following order:

1 $HOME/MagellanNMS
To customizethereportsavailableto asingle user, copy the configuration
file to this directory and make your changes.

2 /opt/MagellanNM S/ cfg
To customize the reports available on aworkstation, copy the
configuration file to this directory and make your changes.

3 /opt/MagellanNMSlib/cfg
Thisdirectory isthe default location of the configuration file. Do not edit
the configuration file in this directory; instead use it as the source when
you want to copy dpnrep.reports to the other directories.

Configuration file format
The dpnrep.reports file contains DtK sh commands in the following format:

createReportBtn <report_name> \
“<report_button_| abel > \

“<bt n_mmenoni ¢c>" “<btn_accel erator>" \
“<btn_acc_| abel >" \

“scriptReport <report_script_name>"

where:

bt n_acc_| abel isthetext string, specifying the keyboard accelerator for
thisreport, that is displayed in the Reports menu.

bt n_accel erat or isthe keyboard accelerator for this report.
bt n_menoni c isthe keyboard mnemonic key for this report.

report_button_| abel isthetext string, specifying thetitle for this
report, that is displayed in the Reports menu.

report_nanme isauniquereport identifier. No spaces are allowed.
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report_script_name isthename of the reporting script. The DPN
Inventory Reportstool searchesfor the script in the following directories
and in the following order:

$HOME/MagellanNM S

/opt/MagellanNM S/cfg/macros/user

/opt/MagellanNM S/lib/macros/nms.

You can override the default directories by including the full pathname as part
of report_script_name.

Example 1

creat eReport Bt n DPN_PE_REPORT \
“PE | NVENTORY” \

“PTtCirl <Key>p” “Cirl+p” \
“script Report dpnperep”

Example 2
You can produce the same report as above, but from a directory of your
choice by including the full pathname:

creat eReport Bt n DPN_PE_REPORT \

“PE | NVENTORY” \

“PT “Cirl <Key>p” “Cirl+p” \

“scriptReport /home/ nnsuser/ bi n/ dpnperep”

DPN Inventory Reports tool window
The DPN Inventory Reportstool window contains the following sections:

*  “Menubar” (page 40)

* “OA datafield” (page 42)

* “Moduledatafield” (page 42)
e “Report area’ (page 42)
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Figure 6
DPN Inventory Tool window

File Edit Reports Options ﬂelp;

Menu bar
The menu bar islocated at the top of the DPN Inventory Reportstool
window. See the following sections for information on the menu bar entries:

e “Filemenu” (page 40)
e “Edit menu” (page 41)
e “Reportsmenu” (page 41)
e “Options menu” (page 41)

File menu
The File menu contains the following options:

» Saveasopensthe Save Report to Filedialog. Thisdialog lets you save
the report output to afile that you specify. See also “ Save Report to File
dialog” (page 43).
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e Print opensthe Print Report dialog, which allows you to print the
report output. See also “Print Report dialog” (page 44).

» Exit exitsthe DPN Inventory Reportstool.

Edit menu
The Edit menu containsoptionsfor editing text inthereport area. The options

are:
»  Cut removes any selected text and placesit in a cut/copy buffer.
» Copy copies any selected text and placesit in a cut/copy buffer.

» Pasteplacesthelast cut or copied text at the insertion point in the report
area.

» Delete deletes any selected text.

Reports menu
The Reports menu lists all available DPN inventory reports. You can add

custom reports to this menu. Until you specify an OA name or module name
on the DPN Inventory Reportswindow, all reports are grayed out and
unselectable.

The reportslisted in the Reports menu are specified in the configuration file
dpnrep.reports. For moreinformation on thisfile, see“DPN inventory reports
configuration file” (page 37).

Options menu
The Options menu contains the following options:

» Append to Existing Text lets you add any new report output to the
existing report output. If you do not select this option, any new report
output replaces the existing report output. By default, this optionis
enabled.

» GenerateCSV Output letsyou save any new report output asCSV data.
You can use CSV dataas input to a spreadsheet. If you do not select this
option, any new report output is displayed as usual. By defaullt, this
option is disabled.
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OA data field
The OA field is mandatory. Enter the name of the OA on which you want to
report. If you want information on a particular module, enter the module
namein the M odule field.

If you enter the OA and not amodule, the report is produced for all modules
under the specified OA. Subordinate OAs are traversed, with modules under
them also reported on. If you leave the OA and M odule fields blank, you
cannot produce any reports.

Module data field

Thisfield isoptional. You can enter the name of the module on which you
want to report.

Report area
This scrollable area displays the reports you create and any messages
generated by the DPN Inventory Reportstool.

DPN Inventory Reports tool dialogs

See the following sections for information on DPN I nventory Reportstool
dialogs:

e “OA Authentication dialog” (page 42)
» “Save Report to Filedialog” (page 43)
*  “Print Report dialog” (page 44)

OA Authentication dialog
The OA Authentication dialog isdisplayed when you try to generate areport
and you do not have aconnectionto therequired OA. Thisdialog promptsyou
for adestination OA, user 1D, and password, which are required before
authentication can take place.
The buttons are:
*  OK completes the connection and closes the dialog.

»  Cance stopsthe connection attempt and closes the dial og.
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For an illustration of the OA Authentication dialog, see the figure “ OA
Authentication dialog” (page 43).

Figure 7
OA Authentication dialog

— OA Authentication

Authentication for O0&...

Destination: |§|:19111

User ID: |

Fassword: |

| ] .4 | Eancel| Help

Save Report to File dialog
The Save Report to File dialog lets you specify the name of afilefor saving
the current report output.

The buttons are;

»  OK savesyour report in the file you specify and closes the dial og.
» Filter letsyou choose what files are listed.

» Cancd closesthe dialog without saving your report.

For an illustration of the Save Report to File dialog, see the figure “ Save
Report to Filedialog” (page 44).
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Figure 8
Save Report to File dialog

~| Save Report to File
Directories Files -
D | cliss -
e .allas.old J
MPA_data .cshreo

HE .cshro.old

Jll dtprofile
MagellanNMS .dtprofile.old
NODER16 Llozin

sanlty_test ¥ .login.old ;
I | El =
Selection

‘flocalfusevsﬁnmguestﬁ

| 0K | Filter| Cancel Help

Print Report dialog
The Print Report dialog lets you enter a printer name when you print a
report. The Print Report dialog has the following buttons:
*  OK printsthereport and closes the dialog.
e Cancd closesthe dialog without printing the report.

For an illustration of the Print Report dialog, see the figure “Print Report
dialog” (page 45).
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Figure 9
Print Report dialog
— Print Report
Printer:
A 0K | Cancel | Help | I

DPN Inventory Reports tool procedures
See the following sections for information on DPN | nventory Reportstool
procedures:

e “Producing reports using the DPN Inventory Reports tool window”
(page 45)

e “Producing reports using acommand line” (page 46)

Producing reports using the DPN Inventory Reports tool

window
You can select the OA, module, and report fromthe DPN I nventory Reports
tool window. You need to establish a connection to an OA or module before
you can produce a report.

1 Onthe DPN Inventory Reportsl window, fill in the OA and the and/or
Module fields.

If you specify only the OA, the report is produced for all modules in the
specified group. Subordinate OAs are traversed, with modules under
them also reported on.

If you specify only the module, the report is produced only for the specified
module.

Note: You cannot produce a report until you fill in either the OA or the
and/or Module fields.

2 From the Options menu, deselect Append to existing text if you want
the new report output to replace existing report output. By default,
Append to existing text is selected.
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3 Fromthe Options menu, select Generate CSV output if you want to save
the new report output as CSV data. By default, Generate CSV output is
deselected.

4  From the Reports menu, select a report.

If no connection exists to the required OA, the OA Authentication dialog
opens.

In the OA Authentication dialog, enter the Destination OA, User ID, and
Password and click OK.

When a valid connection exists, the report is created and appears in the
report area.

Producing reports using a command line
You can use acommand line to produce reports independently of the
graphical user interface. The report output goes to stdout. The command
syntax is:

/ <pat hnane>/ <r eport _scri pt _nane>
-0a <oa_name> [-cap <capability> -pwd <password]
[-csv] [-h] [rodul e(s)]

where:

capabi l ity isauserID for creating aconnection to therequired OA. You
must specify the -cap option when there is no connection to the required OA.

-csv formatsthe report output in CSV format.
- h displays online help for this command.

modul e(s) isthe name(s) of the DPN module(s) on which you want to
report. Thisfield is not case-sensitive.

oa_name isthe name of the OA on which you want to report. Thisfield is
not case-sensitive.

passwor d isthepassword for creating aconnectiontotherequired OA. You
must specify the -pwd option when thereisno connection to the required OA.

pat hnane isthe directory where the report script resides.
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report_script_name isthe script name of the report that you need to
produce. The script names of available reports are specified in the
configuration file dpnrep.reports using the option

scriptReport <report_script_name>. See “Configuration file format”
(page 38) for more information.

Note: All command options must appear before the module names.

Examples

The following command is used to produce the DPN SCR Report for
specified RMs. Thedirectory containing the report scriptsthat comewith
the Preside Multiservice Data Manager (MDM) software is used. The
report is produced using a new connection and the ouput isformatted in
CSV format.

[ opt/ Magel | anNVB/ | i b/ macr os/ nns/ dpnscrrep -oa nmi noa
-cap capcnd -pwd cappwd -csv RML RV RMVB

The following command is used to produce the DPN Full Module
Report for all modules. The report is produced using an existing
connection.

[ opt/ Magel | anNVB/ | i b/ macr os/ nns/ dpnnodr ep - oa nmi noa

Using the keyboard
You can produce any DPN inventory report by using its command accel erator,
which is displayed in the Reports menu.

In addition, the DPN Inventory Reports tool provides the following
keyboard shortcuts:

* Citrl+sfor Save as

e Ctrl+pfor Print

o Ctrl+efor Exit

Some characters in menus and in menu items have an underscore (). These

characters are mnemonics that you can use instead of using the mouse. Use
the Meta key in combination with the mnemonics.
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Examples
Meta+f on the DPN I nventory Reportstool window opens the File
menu.

Metat+c on the Edit menu is the same as Copy.
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Appendix A
Passport Inventory Reports

This appendix provides examples of the reports that come with the Passport
Inventory Reportstool. See the following sections for information on these
reports:

*  “Available Passport Groups and Modules (pplistrep)” (page 50)
e “Passport Full Module Report (ppmodrep)” (page 51)

e “Passport Card Inventory (ppcardrep)” (page 53)

e “Passport Trunk and DPNGate Report (pptrkrep)” (page 54)

e “Passport Software Report (ppsoftrep)” (page 55)

e “Passport Frame Relay Services Report (ppfrrep)” (page 58)

e “Passport ATM Services Report (ppatmrep))” (page 60)
e “Passport Frame Relay ATM Services Report (ppfratmrep)” (page 62)
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Available Passport Groups and Modules (pplistrep)

This report lists the available Passport modules and groups by querying the
HGDS server.

The following example shows the Available Passport Groups and Modules
report.

Avai | abl e Passport G oups and Mdul es

Server: bhars836
Date: Tue Feb 15 11:53:35 GMI 2000

Group: ALPHA
BHARY145
BUNGLE
GEORCE
ZI PPY

BHARY12C
BHARY134
BHARY136
BHARY144
BHARY46D
BHARY472
BHARY491
BHARY492
BHARY49C
BHARY7F9
BHARY7FE
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Passport Full Module Report (ppmodrep)
This report provides a full inventory of a Passport module, including the
module name, node ID, NAMS ID, network ID, routing ID, module ID, and
model. In addition, it containsinformation about thefile system and disksand
all of theinformation contained in the Passport Card Inventory and Passport

Trunk and DPNGate reports.

The following example shows a Passport Full Module Report.

Passport Ful |

Mbdul e Report

Server: bhars836
Date: Tue Mar 28 16:29:08 BST 2000
Node Name: CGEORGE
Node ID: 2
NAVS | D: 7002
Network ID: 1
Routing ID: 7
Module 1D 2
Software Level: BEOOS9B
Slots: 16
Card Type I nserted Serial # Product Code LP
0 CcP CcP NNTMD3013KMB NTFN33AA- 08 Lp/ 0
1 2pDS3cAal 2pDS3cAal 15XML “ Lp/1
2 V35 V35 FT003876 NTBP16DB- 01 Lp/ 2
3 Vil Vi1l FT003896 NTBP38EA- 01 Lp/ 3
4 3pE1lAt m 3pElAt m NNTMD3004W/C NTFP32AB- 01 Lp/ 4
5 1pElV 1pE1lV PPSN003099 NTFP43AB- 03 Lp/ 5
6 2pJ6MAL m 2pJ6MAL m NNTMD3004NYK NTFP58AB- 01 Lp/ 6
7 4pDS1Aal 1 4pDS1Aal 1 NNTMD30089NR NTFP80AB- 01 Lp/ 7
8 3pDS3At m 3pDS3At m NNTMD3012CDF NTFP18DA- 02 Lp/ 8
9 2pJ6MAL m 2pJ6MAt m NNTMD3004NYG NTFP58AB- 01 Lp/ 6
10 4pElAal 1 4pElAal 1 NNTMD3011ZGD NTFP82AC- 01 Lp/ 10
11 12nVspAsl 12nVspAsl e NTFN87AB- 06 Lp/ 11
12 none none None None
13 4pDS1Aal | 4pDS1Aal | NNTMD3014B6P NTEP80OAC- 04 Lp/ 12
14 4pElAal 1 4pElAal 1 NNTMD3011D9M NTFP82AA- 05 Lp/ 14
15 CcP none None None
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Trunk Type M Speed M Del ay Renpte Name Renpte Endpoint
(bits/s) (msec)

Trk/ 1 PORS 0 0.0

Trk/ 2 PORS 1918000 1.4 EM ZI PPY TRK/ 2
Trk/ 3 PORS 0 0.0

Trk/ 4 PORS 0 0.0

Trk/ 31 PORS 0 0.0

Trk/ 60 PORS Atm 1152000 1.0 EM HARRY TRK/ 31
Trk/ 801 PORS Atm 6144000 0.3 Zi ppy EM ZI PPY TRK/ 801
Trk/ 802 PORS Atm 6144000 0.3 Zi ppy EM ZI PPY TRK/ 802
Trk/ 803 PORS Atm 6144000 0.3 Zippy EM ZI PPY TRK/ 803

File System
Vol ume Nane: GEORGE
Active Disk: Fs
Synchroni zed: unSynchroni zed
Capacity: 811122688 bytes
Free Space: 232079360 bytes
Usage: 71 %

Di sk: Disk/0
Vol ume Nane: GEORGE
Capacity: 811122688 bytes
Free Space: 232079360 bytes
Bad Bl ocks: 0 %
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Passport Card Inventory (ppcardrep)

Thisreport providesafull card inventory for a Passport module. You can sort

and filter the report output by card type. The following information is

displayed for each card: module name, card number, configured card type,
inserted card type, card serial number, product code, and logical processor.

The following example shows a Passport Card | nventory report.

Passport Card Inventory

Card Type

0 cP

1 2pDS3cAal
2 V35

3 V11

4 3pE1At m

5 1pE1V

6 2pJ6NMAt m
7 4pDS1Aal 1
8 3pDS3At m
9 2pJ6NMAt M
10 4pElAal 1

11 12nVspAal
12 none

13 4pDS1Aal 1
14  4pElAall

15 cP

0 cP

1 DSs1

2 4pDS1Aal 1
3 2pJ6MAt M
4 V11

Server:

bhar s836

Date: Tue Feb 15 11:55:49 GMVI 2000

I nserted

2pDS3cAal
V35

V11
3pE1IAt m
1pE1lV
2pJ6MAt m
4pDSi1Aal 1
3pDS3At m
2pJ6MAt m
4pElAal 1
12nVspAal
none
4pDS1Aal 1
4pElAal 1
none

cP

DS1
4pDS1Aal 1
2pJ6MAt m
V11

Serial #
NNTMD3013KM3
15XML
FT003876
FT003896
NNTMD3004W/C
PPSN003099
NNTMD3004NYK
NNTMD30089NR
NNTMD3012CDF
NNTMD3004NYG
NNTMD3011ZGD
None
NNTMD3014B6P
NNTMD3011D9M
None
NNTMD30018PS
FT002261
NNTMD3011VY8
NNTMD3002W60
FT003986

Product Code

NTFN33AA- 08
NTBP16DB- 01
NTBP38EA- 01
NTFP32AB- 01
NTFP43AB- 03
NTFP58AB- 01
NTFP80AB- 01
NTFP18DA- 02
NTFP58AB- 01
NTFP82AC- 01
NTFN87AB- 06
None

NTFP80AC- 04
NTFP82AA- 05
None

NTBP12CA- 03
NTBP19DA- 01
NTFP80AC- 01
NTFP58AA- 02
NTBP38EA- 01
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Passport Trunk and DPNGate Report (pptrkrep)
This report provides information about trunks and DPN gateways. The
following information is displayed for each trunk: trunk name, trunk type,
measured speed, measured delay, configured remote name, and current
remote endpoint component.

Thefollowing information isdisplayed for each DPN gateway: DPN gateway
name, gateway type, measured speed, measured delay, configured remote
NAMS ID, and current remote endpoint component.

The following example shows a Passport Trunk report.

Passport Trunk Report

Server: bhars836
Date: Tue Feb 15 11:56: 08 GMI 2000

Node Name: CEORGE (in group: ALPHA)

Trunk Type M Speed M Del ay Renpote Nane Renpte Endpoi nt
(bit/s) (nmsec)

Trk/1 PORS 0 0.0

Trk/ 2 PORS 1917000 1.6 EM ZI PPY TRK/ 2
Trk/ 3 PORS 0 0.0

Trk/ 4 PORS 0 0.0

Trk/ 31 PORS 0 0.0

Trk/ 41 PORS Atm 0 0.0

Tr k/ 60 PORS Atm 1152000 1.0 EM HARRY TRK/ 31
Trk/ 111 PORS Atm 0 0.0 OXFORD

Trk/ 112 PORS Atm 0 0. 0 OXFORD

Trk/ 113 PORS Atm 0 0.0 OXFORD

Trk/ 121 PORS Atm 9984000 0.3 HARRY EM HARRY TRK/ 421
Trk/ 122 PORS Atm 9984000 0.2 HARRY EM HARRY TRK/ 422
Trk/ 123 PORS Atm 9984000 0. 2 HARRY EM HARRY TRK/ 423
Trk/ 801 PORS Atm 6144000 0.3 Zippy EM ZI PPY TRK/ 801
Tr k/ 802 PORS Atm 6144000 0.3 Zi ppy EM ZI PPY TRK/ 802
Tr k/ 803 PORS Atm 6144000 0.3 Zi ppy EM ZI PPY TRK/ 803
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Passport Software Report (ppsoftrep)

This report provides an inventory of the available and active software on a
Passport module. Additionally, if more than one Passport nodeisreported, the
report generates two summaries:

» Active Software Version Summary

e Software Version On Disk Summary

The Passport Software Report displays the name, version, any installed
patches, and status for each application that is found.

The following example shows a Passport Software Report with the two
summary reports.

Passport Software Report

Server: wcary204
Dat e: Thursday November 8 13:49:26 EST 2001

Node Nane ROVE (in group: NMDM.AB)

Application Ver si on( Pat ch) St at us
aal 1Ces BD0218A

aal 1Ces BD0226A

at nBear er Servi ce BDO1A

at nBear er Ser vi ce BD0216A

at nBear er Servi ce BD0218A

at nBear er Servi ce BD0226A active
at mNet wor ki ng BDO1A

at nNet wor ki ng BDO216A

at nNet wor ki ng BDO218A

at mNet wor ki ng BD0O226A active
base BDO1A

base BD0216A

base BD0218A

base BD0226A active
base CB0359A

bri dge BDO1A

bri dge BDO216A

bri dge BD0O218A

bri dge BD0226A active
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f rameRel ay

f rameRel ay

f rameRel ay
frameRel ay

i nwBase

i nwBase

i nwBase

i nwBase

ip

ip

ip

ip

i px

i px

i px

i px

net Sentry
net Sentry
net Sentry
net Sentry
net wor ki ng
net wor ki ng
net wor ki ng
net wor ki ng
servi ceTrace
servi ceTrace
sna

sna

sna

sna

swi t chedAccess
swi t chedAccess
swi t chedAccess
swi t chedAccess
test Tool s
test Tool s

t est Tool s
test Tool s
trunks
trunks
trunks
trunks
trunks

BDO1A

BDO216A
BDO218A
BD0226A
BDO1A

BDO216A
BDO218A
BD0226A
BDO1A

BDO216A
BDO218A
BD0226A
BDO1A

BDO216A
BDO218A
BD0226A
BDO1A

BDO216A
BDO218A
BD0226A
BDO1A

BDO216A
BDO218A
BDO226A
BDO218A
BD0226A
BDO1A

BDO216A
BDO218A
BDO226A
BDO1A

BDO216A
BDO218A
BD0226A
BDO1A

BDO216A
BDO218A
BD0226A
BDO1A

BDO216A
BDO218A
BD0226A
CAO0226A

act

act

acti

act

act

acti

act

act

acti

act

ve

ve

ve

ve

ve

ve

ve

ve

ve

ve
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vns
vns
vns
vns

vt ds
vt ds
vt ds
vt ds
wanDt e
wanDt e
wanDt e
wanDt e

Node Nane:

ATHENS

(i

BDO1A

BD0216A

BD0218A

BD0226A active
BDO1A

BD0216A

BD0218A

BD0226A active
BDO1A

BD0216A

BD0218A

BD0226A active

n group: NDM_AB)

aal 1Ces

at nNet wor ki ng
at nNet wor ki ng
at mNet wor ki ng
at mNet wor ki ng

base

base

base

base
frameRel ay
frameRel ay
frameRel ay
frameRel ay
ip

ip

ip

ip

net wor ki ng
net wor ki ng
net wor ki ng
net wor ki ng

CB0031B

CB02S3E

CCO067A active
CB0031B

CB02S3E

CCO067A active
UWWVB4AEd

CB0031B

CB02S3E

CCO067A active
UWWVB4AEd

CB0031B

CB02S3E

CCO067A active
UWWB4AEd

CB0031B

CB02S3E

CCO067A active
UWWVB4AEd

CB0031B

CB02S3E

CCO067A active
UWWVB4AEd
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Active Software Version Sunmary

Passport Frame Relay Services Report (ppfrrep)
This report provides an inventory of the Frame Relay services and
connections that are available on a Passport module. The following
information is displayed for each Frame Relay service: interface name,
logical processor, customer 1D, LMI type, and DNA.

Thefollowing information isdisplayed for each Frame Relay connection that
isfound: DLCI name, connection type, CIR, EIR, rate enforcement status,
rate adaptation status, remote DNA, and remote DL CI.

The following example shows a Passport Frame Relay Services Report.

Passport Frame Rel ay Services Report

Server: bhars836
Date: Tue Feb 15 11:56: 47 GVI 2000

Frane Relay Service: FrUni/30
Logi cal Processor: Lp/3 X21/0
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Custorer ID: O
LM Type: none
DNA: x121 111170020030

DLCl Type CIR El R Rat e Rat e Renot e DNA Rem

(bits/s) (bits/s) Enforced Adaptation DLCI
50 pvc 64000 0 no no x121 111170010000 16
51 pvc 64000 0 no no x121 111170020000 16
52 pvc 64000 0 no no x121 111170030000 17
53 pvc 64000 0 no no x121 111170040000 17

Frane Relay Service: FrUni/33
Logi cal Processor: Lp/3 X21/3
Custoner ID: O
LM Type: ansi

DNA: x121 111170020033
DLCl Type CIR El R Rat e Rat e Renot e DNA Rem
(bits/s) (bits/s) Enforced Adaptation DLC
200 pvc 64000 0 yes no x121 111170010033 200
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Passport ATM Services Report (ppatmrep))

This report provides an inventory of the ATM services and connections that
are available on a Passport module. The following information is displayed
for each ATM service: Atmlf name and type, logical processor, customer 1D,
number of configured permanent VCCsand V PCs, number of active switched
V CCs, number of troubled VCCs and V PCs, traffic shaping state, UPC state,
and total admitted and available bandwidth.

Thefollowing information is displayed for each ATM connection: VCC/VPC
name, connection type, service category, OAM segment type, transmit side
traffic type and QoS, receive side traffic type and QoS, traffic shaping and
UPC shapes, and end/relay component name.

The following example shows a Passport ATM Services Report.

Passport ATM Services Report

Node Nane:

Server: bcaruff9

Date: Wed Apr 10 13:41:26 EDT 2002

ATLANTA (in group: NDMLAB)

ATM Servi ce:

Atm /10 (PUNI)

End/ Rel ay Poi nt

ATM F/ 10 PNNI SI G
ATM F/ 10 PNNI RCC

Logi cal Processor: Lp/1 DS3/0
Remote ATM Interface: n/a
Custoner 1D 0O

Permanent: VCCs: 5 VPCs: 2

Swi tched: VCCs: 13

Troubled: VCCs: 0 VPCs: O

Bandwi dth: Admitted: 1089 Avail able: 103179
Vcc/ Vpc Type Role Categ. Tx QOS Rx QOS Shap UPC
Vee/ 0.5 EP COnEP rtVbr 6 6 of f
Vee/ 0. 18 EP COnEP rtVvbr 8 8 of f
Vcc/ 0. 66 RP segEP cbr 1 1 n/a

ATM F/ 10 VCC/ 0. 207 RP
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Vcc/ 0. 67 RP segEP cbr 1 1 n/ a
Vcc/ 0. 68 RP segEP cbr 3 3 n/a
Vcc/ 0. 75 NRP  segEP ubr 3 3 of f
Vcce/ 0. 85 ™ unkn ubr 1 1 n/a
Vcc/ 0. 207 RP segEP cbr 1 1 n/ a
Vcc/ 0. 208 RP segEP cbr 1 1 n/ a
Vcc/ 0. 209 RP segEP cbr 3 3 n/a
Vcc/ 0. 629 RP segEP ubr 1 1 n/a
Vcc/ 0. 630 RP segEP cbr 3 3 n/a
Vcc/ 0. 632 RP segEP cbr 1 1 n/a
Vcc/ 0. 634 RP segEP ubr 1 1 n/a
Vcc/ 0. 635 RP segEP ubr 1 1 n/a
Vcc/ 0. 637 RP segEP cbr 1 1 n/ a
Vcc/ 0. 639 RP segEP cbr 1 1 n/ a
Vcc/ 0. 640 RP segEP cbr 3 3 n/ a
Vpc/ 20 NRP  segEP ubr 3 3 of f
Vpc/ 25 NRP  segEP ubr 3 3 of f
Vpc/ 124 RP segEP ubr 1 1 n/ a
Vpc/ 125 RP segEP ubr 1 1 n/a
Vpc/ 126 RP segEP cbr 1 1 n/a
Vpc/ 127 RP segEP cbr 1 1 n/a
ATM Service: Atmf/11 (PUNI)
Logi cal Processor: Lp/1 DS3/1
Remote ATM Interface: n/a
Custoner 1D 0O
Permanent: VCCs: 4 VPCs: 5
Swi tched: VCCs: 9
Troubled: VCCs: 0 VPCs: O
Bandwi dth: Admitted: 1083 Avail able: 103185

Vcc/ Vpc Type Role Categ. Tx QOS Rx QOS Shap
Vce/ 0.5 EP ConEP rtVvbr 6 6 of f
Vee/ 0. 18 EP COnEP rtVvbr 8 8 of f
Vcc/ 0. 50 RP segEP ubr 1 1 n/a
Vcc/ 0. 56 RP segEP cbr 3 3 n/ a
Vce/ 0. 66 ™ unkn cbr 1 1 n/a

n/ a
of f
of f
n/ a
n/ a
n/ a
of f
n/a
of f
n/a
n/a
n/a
n/ a
n/ a
of f
of f
of f
n/ a
n/a
n/a
n/a

UPC
of f
of f
n/ a
of f
n/ a

ATM F/ 10
ATM F/ 10
ATM F/ 11

VCC/ 0.
VCC/ 0.
VCC/ 0.

208 RP
209 RP
75 NRP

ATM F/ 10
ATM F/ 10
ATM F/ 10
ATM F/ 11
ATM F/ 11
ATM F/ 11
ATM F/ 11
ATM F/ 11
ATM F/ 11
ATM F/ 11
ATM F/ 11
ATM F/ 11
ATM F/ 11
ATM F/ 11
ATM F/ 11
ATM F/ 11
ATM F/ 11

VCC/ 0.
VCC/ 0.
VCC/ 0.
VCC/ 0.
VCC/ 0.
VCC/ 0.
VCC/ 0.
VCC/ 0.
VCC/ 0.

66 RP
67 RP
68 RP
80 RP
150 RP
152 RP
170 RP
50 RP
117 RP
VCC/ 0. 197 RP
VCC/ 0. 56 RP
VPC/ 20 NRP
VPC/ 25 NRP
VPC/ 10 RP
VPC/ 11 RP
VPC/ 100 RP
VPC/ 101 RP

End/ Rel ay Poi nt

ATM F/ 11 PNNI SI G
ATM F/ 11 PNNI RCC
ATM F/ 10 VCC/ 0. 635 RP
ATM F/ 10 VCC/ 0. 640 RP
ATM F/ 10 VCC/ 0. 207 RP
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Vcc/ 0. 75 NRP  segEP ubr 3 3 off off ATMF/ 10 VCCU 0.75 NRP
Vcc/ 0. 80 RP segEP ubr 1 1 n/a n/a ATMF/ 10 VCCU 0.629 RP
Vce/ 0. 100 NEP  conEP ubr 1 1 nfa n/la ATMWE/ 14 AC/ 1

Vcc/ 0. 117 RP segEP cbr 1 1 n/a n/a ATMF/ 10 VCCU 0.637 RP
Vcc/ 0. 150 RP segEP cbr 3 3 n/a off ATMF/ 10 VCCU 0.630 RP
Vcc/ 0. 152 RP segEP cbr 1 1 n/a n/a ATMF/ 10 VCCU 0.632 RP
Vcc/ 0. 170 RP segEP ubr 1 1 n/a n/a ATMF/ 10 VCC 0.634 RP
Vcc/ 0. 197 RP segEP cbr 1 1 n/a n/a ATMF/ 10 VCC 0.639 RP
Vpc/ 10 RP segEP ubr 1 1 n/fa n/la ATMF/ 10 VPC 124 RP
Vpc/ 11 RP segEP ubr 1 1 nfa n/a ATMF/ 10 VPC 125 RP
Vpc/ 12 ™ unkn ubr 1 1 nfa nla

Vpc/ 20 NRP  segEP ubr 3 3 off off ATMF/ 10 VPC 20 NRP
Vpc/ 25 NRP  segEP ubr 3 3 off off ATMF/ 10 VPC 25 NRP
Vpc/ 100 RP segEP cbr 1 1 n/fa n/a ATMF/ 10 VPC 126 RP
Vpc/ 101 RP segEP cbr 1 1 n/a n/la ATMF/ 10 VPC 127 RP
------------------------------ done --------------oiaii oo

Passport Frame Relay ATM Services Report (ppfratmrep)

This report provides an inventory of the Passport frame relay to ATM (FR-
ATM) service and connectionsthat are available on the Passport module. The
report displays the following information for each FR-ATM service:

e FR-ATM name

» logical processor (Lp)
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* customer ID

* Loca Management Interface (LMI) type

» total admitted and available bandwidth
The report displays the following information for each frame relay to ATM
connection that is found:

* DLCI name

e connection type

e committed information rate (CIR) in bits/s
e excessinformation rate (EIR) in bits/s

* rate enforcement status

e service category

*  remote address

* remote Cl

* next hop

The following example shows a Passport Frame Relay ATM Servicesreport.

Passport Frame Rel ay ATM Services Report

Server: bcaruff9

Date: Wed Apr 10 14:24:34 EDT 2002
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Node Nane: NAGANO (in group: MDVLAB)

Frane Relay ATM Service: FrAtnm 20
Logi cal Processor: Lp/2
Custoner 1D O
LM Type: autoConfigure
Bandwi dth: Adnmitted: O Available: 0

DLCl Type R El R Rat e Servi ce Renote Address
Renot e Next Hop

(bits/s) (bits/s) Enforced Category

c

16 siwf 56 n/ a of f
At f/ 12 Vcc/ 0.120 Nep

33 siwf 64000 n/a on
At f/10 Vcc/ 0. 33 Nep

35 siwf 64 n/ a of f
At f/10 Vcc/ 0.139 Nep

36 siwf 64 n/ a of f
Atm f/10 Vcc/0.138 Nep

37 siwf 64 n/ a of f
Atm f/12 Vcc/0.175 Nep

49 siwf 64 n/ a of f
Atmif/10 Vcc/0.35 Nep

106 siwf 60 n/ a of f
At f/10 Vcc/0.106 Nep

107 siwf 58 n/a of f

At f/ 10 Vcc/ 0. 107 Nep

241-6001-808 14.3RSUP



Appendix A Passport Inventory Reports 65

111 siwf 64000 n/a of f
Atmf/12 Vcc/ 0. 46 Nep
119 siwf 56 n/a of f
At f/10 Vcc/ 0.36 Nep
127 siwf 64000 n/ a of f
Atm f/10 Vcc/0.151 Nep
128 siwf 128000 n/ a of f
At f/ 10 Vcc/ 0. 152 Nep
129 siwf 64000 n/ a of f ubr
471391111111111122111111B00020480D000A00 0. 166 Atm /10 Vcc/ 0. 166 Ep
130 siwf 64000 n/a of f ubr
471391111111111122111111A00020480D000A00 0. 162 Atm /10 Vcc/ 0. 293 Ep
132 siwf 128000 n/a of f ubr
47139111112111111221111111A00020480D000A00 0. 163 Atm /10 Vcc/ 0.292 Ep
136 siwf 64 n/ a of f
At f/10 Vcc/ 0.136 Nep
137 siwf O n/ a of f
At f/ 10 Vcc/ 0. 137 Nep
140 siwf 56 n/ a of f
At f/ 12 Vcc/ 0.35 Nep
Frane Rel ay ATM Service: FrAtm 1000
Logi cal Processor: Lp/2
Customer ID. O
LM Type: autoConfigure
Bandwi dt h: Admitted: O Available: 0

DLCI Type CIR El R Rat e Servi ce Renote Address
Renot e Next Hop
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(bits/s) (bits/s) Enforced Category

Cl
16 siwf 40000 n/a of f

Atm f/12 Vcc/0.115 Nep
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Appendix B

DPN Inventory Reports

This appendix provides examples of the reports that come with the DPN
Inventory Reportstool. See the following sections for information on these
reports:

“DPN Module Report (dpnmodrep)” (page 68)

“DPN Module Summary (dpnsumrep))” (page 69)

“DPN PE Report (dpnperep))” (page 70)

“DPN PI Report (dpnpirep)” (page 71)

“DPN SCR Report (dpnscrrep)” (page 73)

“DPN Network Links and Trunks Report (dpnnetrep)” (page 75)
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DPN Module Report (dpnmodrep)

Figure 10

This report provides afull inventory of a DPN module, including the node
name, NAMS ID, node type, model, number of shelves, common memory,
maximum subnet packet size, and information about disk capacity. In
addition, it includes all of the information contained in the DPN PE Report
and DPN Pl Report.

For an example of a DPN Module Report, see the figure “DPN Module
Report” (page 68).

DPN Module Report

File Edit Reports Options

DPN Inventory Reports =

Help

0A: | gocwt

Module: [az001

OFN Modula Report

Server: bearuffd

Date: Wed Mov 7 10:04:28 £ST 2001

OA: DOCHL
Modula Name NAMSID Type Model Shelves CH Subivet Pkt Size Volume nawe Bytes used Bytes left Bytes total Block size
n3eo 3001 M DPN-100 AMSEM 1 1 CMme 012 Az o o o [+
Module Mame FE Type Mem  Muschsn gz Gonuric
il | A3oo1 1 FE386 2048k no AMOF F 386 G365
Iml 2 PE38S 2048k no UTP3&E G336
Hodule Mame PE PI PI Tuype No of Ports Port Protocol Speed (bps) r
I | azoo1 1 1 V35 5051 1 1 um SEK
i | A3001 2 2 VIS SCSI 2 1 umr SEK
: AI001 2 2 VIS5 5051 2
i
el
1= — — — — — — — — —
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DPN Module Summary (dpnsumrep))
Thisreport carriesall of theinformation contained inthe DPN Module Report
(module name, NAMS ID, node type, model, number of shelves, common
memory, and maximum subnet packet size) except for the information from
the DPN PE Report and DPN Pl Report.

The following example shows a DPN Module Summary Report.

DPN Modul e Summary Report

Server: whars062
Dat e: Tuesday August 24 10:29: 05 BST 1999

OA: bnroa
Modul e Name NAMSI D Type Mbddel Shel ves CM Subnet Pkt Size
AML 1002 AM DPN-100 AMRM 1 2 M6 512
------------------------------ doNe - --- -
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DPN PE Report (dpnperep))

Thisreport providesafull inventory of the PEs present inaDPN module. The
following information is displayed for each PE that is found: module name,
PE number, type, memory, M uxdma operating mode, image, and software
generic.

The following example shows a DPN PE Report.

DPN PE Repor t

Server: whars062
Dat e: Tuesday August 24 09:53:02 BST 1999

OA: bnroa

Modul e Name PE Type Mem  Muxdma | mage Generic
AML 1 PE386 2048K no AMOFF386 G36

AML 2 PE386 2048K no CSERV386 G36

AML 3 PE386 2048K no UTP386 G36

AML 4 PE386 2048K no FRELAY G36

AML 5 PE386 2048K no FRELAY G36

AML 6 PE386 2048K no X25DP386 G36

AML 7 PE386 2048K no X25DP386 G36

AML 8 PE386 2048K no X25B386 G36

AML 9 PE386 2048K no X25B386 G36

AML 10 PE386 863K no PELFGL G36

AML 11 PE386 863K no PELFGL G36

AML 12 PE386 2048K no UTP386 G36

AML 13 PE386 2048K no FRELAY G36

AML 14 PE386 2048K no AMOFF386 G36
------------------------------ doNe ------ oo
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DPN Pl Report (dpnpirep)
Thisreport providesafull inventory of the Pls present inaDPN module. The
following information is displayed for each Pl that is found: module name,
PE number, Pl number, type, and number of ports.

The following information is displayed for each port: port number, protocoal,
and configured speed.

The following example shows a DPN Pl Report.

DPN Pl Report

Server: whars062
Dat e: Tuesday August 24 09::57 BST 1999

OA: bnora

Modul e Nanme PE Pl Pl Type No of Ports Port Protocol Speed (bps)
AML 1 1 V35_SCSI 0

AML 2 2 V36_FOUR _PORT 0

AML 3 3 V35_SCSI 2 1 UTpP 64K
AML 3 3 V35_SCSI 2 UTpP 19. 2K
AML 4 4 PR MARY_RATE 1 1 FRS 2048K
AML 5 5 PR MARY_RATE 1 1 FRS 2048K
AML 6 6 PR MARY_RATE 1 1 LAPD X25 64K
AML 7 7 PR MARY_RATE 1 1 LAPD X25 64K
AML 8 8 V24_FOUR PORT 3 1 X25 9600
AML 8 8 V24_FOUR PORT 2 X25 9600
AML 8 8 V24_FOUR PORT 3 X25 9600
AML 9 9 V24 _FOUR _PORT 4 1 X25 9600
AML 9 9 V24 _FOUR_PORT 2 X25 9600
AML 9 9 V24_FOUR_PORT 3 X25 9600
AML 9 9 V24_FOUR_PORT 4 X25 9600
AML 10 10 V24_El GAT_PORT 8 1 I Tl 9600
AML 10 10 V24_El GAT_PORT 2 I Tl 9600
AML 10 10 V24_El GAT_PORT 3 I Tl 9600
AML 10 10 V24_El GHT_PORT 4 I Tl 9600
AML 10 10 V24_El GHT_PORT 5 I Tl 1200
AML 10 10 V24_El GHT_PORT 6 I Tl 1200
AML 10 10 V24_El GHT_PORT 7 I Tl 9600
AML 10 10 V24_El GHT_PORT 8 [Tl 9600
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AML 11 11 V24_FOUR_PORT 4 1 I TI 1200
AML 11 11 V24_FOUR_PORT 2 I TI 9600
AML 11 11 V24_FOUR_PORT 3 | TI 9600
AML 11 11 V24 _FOUR_PORT 4 | Tl 9600
AML 12 12 V35_SCsI 2 1 UTP 64K
AML 12 12 V35_SCsI 2 UTP 19. 2K
AML 13 13 V24_El GHT_PORT 2 1 FRS 256K
AML 13 13 V24 _El GHT_PORT 2 1 FRS 256K
AML 14 14 V35_SCsI 0
------------------------------ (o [o] g I i
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DPN SCR Report (dpnscrrep)

This report provides a table of source call router (SCR) entries for an RM
module. Thefollowing information isdisplayed for each SCR entry: network
plan indicator (NPI), destination DNA, RID (for intra-network calls) or NID
(for inter-network calls), and RID/NID value.

Modul e: RML

SCR:

2

The following example shows a DPN SCR Report.

DPN SCR Report

Type

1111009
1111009
1111009
1111100
1111100
1111100
1111100
1111123
1111123
1111200
1111200
1111234
1111300
1111666
1111700
1111700
111197
2352
2353
2371987
2371
245612

RI D
RI D
RI D
RI D

0904 NI D

RI D
RI D
NI D
NI D
RI D
RI D
NI D
RI D
RI D
RI D
RI D
NI D
NI D
NI D
NI D
NI D
NI D

Val ue

250
1400
1450
1371
1000
1000

Server: bhars786
Date: Tue Feb 17 11:31:09 GVI 1999

OA: BNRMD
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x121
x121
x121
x121
x121
x121
x121
x121
x121
x121
x121
x121
x121
el64
el64

245659
2468
2624111 1
3030

3143

3333
3456122 00
345659
4270

4280

4321

7999

8999

0628

0753

RI D
NI D
RI D
NI D
NI D
RI D
NI D
RI D
NI D
NI D
NI D
NI D
RI D

1100

300
1550
10
1000

427
428
1500
1000
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DPN Network Links and Trunks Report (dpnnetrep)

This report provides alist of the network links and trunks that are available
on a DPN module. The following information is displayed for each network
link and trunk: PI, PO, speed, Muxdma operating mode of the PE, PE number,
and destination node NAMS ID.

The following example shows a DPN Network Links and Trunks Report.
DPN Net wor k Links and Trunks Report

Server: bhars786
Date: Tue Feb 17 11:31:36 GVI' 1999
OA: BNRMDI

Modul e:  AML
Net wor k Li nks:

Pl PO Speed (bps) Mixdnma PE Destination (Nansid)

3 1 64K no 3 2002
12 1 64K no 12 1001
------------------------------ done ---------mi -
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